
Avid® Editing Application
ReadMe for Media Composer® v6.5.4, NewsCutter® v10.5.4, 
and Symphony™ v6.5.4

IMPORTANT: Avid periodically makes software updates available for download on 
Avid.com at the following location:www.avid.com/us/support/downloads. Please 
check the above site regularly for information on available downloads for your 
product.

Important Information

Avid® recommends that you read all the information in this ReadMe file thoroughly before 
installing or using any new software release.

Important: Search the Avid Knowledge Base for the most up-to-date ReadMe file, which 
contains the latest information that might have become available after the documentation was 
published.

This document describes compatibility issues with previous releases, software installation 
instructions, hardware and software requirements, and summary information on system and 
memory requirements. This document also lists hardware and software limitations.
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

(Windows), (Windows 
only), (Macintosh), or 
(Macintosh only)

This text indicates that the information applies only to the specified 
operating system, either Windows or Macintosh OS X.

Bold font Bold font is primarily used in task instructions to identify user interface 
items and keyboard sequences.
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If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after the 
documentation was published. Also check online for the most up-to-date ReadMe because 
the online version is updated whenever new information becomes available. To view the 
online ReadMe, select ReadMe from the Help menu, or visit the Knowledge Base at 
http://www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues. In addition to the printed documentation supplied 
with your editing application, the documentation is supplied in PDF format when you install 
the application. Topics that you print from the Help have limited page layout and formatting 
features. If you want to print a higher quality version of Help information, Avid recommends 
that you print all or part of the PDF version of the appropriate Avid manual included in the 
Online Library for your editing application. To access the Online Library, select Help > 
Online Library from within your Avid editing application. 

4. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available 24 
hours per day, 7 days per week. Search the Knowledge Base to find answers, to view error 
messages, to access troubleshooting tips, to download updates, and to read or join online 
message-board discussions.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Command+Option+C or Ctrl+drag.

Symbol or Convention Meaning or Action

http://www.avid.com/readme
http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport
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Changed in v6.5.4 and v10.5.4

The following changes were made in Media Composer v6.5.4, Symphony 6.5.4, and NewsCutter 
v10.5.4.

Important Compatibility Information for Macintosh Editor v6.5.4

With this release, if you have a Macintosh editor in an Interplay environment, you must have 
Interplay v2.7.5 client software installed on your Macintosh system. 

XDCAM EX 35 Capture

With this release, you can select XDCAM EX 35 for capture for any project types that support 
XDCAM EX.

Fixed in Media Composer v6.5.4, Symphony v6.5.4, 
and NewsCutter v10.5.4

The following have been fixed:

➤ Bug Number: UDevC00167923. The editing application would crash if the E-mail Setting was 
set to an incorrect SMTP server.

➤ Bug Number: UDevC00168159. In some instances, FilmScribe displayed an exception if you 
changed settings in the Remote Settings window.

➤ Bug Number: UDevC00171742. FilmScribe and EDL Manager did not work properly if UAC 
was enabled on a Windows 7 system.

➤ Bug Number: UDevC00156917. Send To Playback Encode option was not enabled after 
creating a New user profile.

➤ Bug Number: UDevC00178805. Opening a sequence in EDL Manager might have resulted in 
“File not valid” or “Assertion failed” errors.

➤ Bug Number: UDevC00178689. If you opened the Effect Editor after applying an audio effect, 
“Unavailable Effect” was listed.

➤ Bug Number: UDevC00176611. In some instances, performing an Audio Mixdown with Sync 
Locks enabled changed the Timeline length.
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➤ Bug Number: UDevC00174657. Importing ProRes 444 Alpha channel did not import properly.

➤ Bug Number: UDevC00181499. Importing an image with an Avid Pan & Zoom effect could 
have caused the system to hang or crash.

➤ Bug Number: UDevC00180453. The Title Tool did not apply the Safe Colors setting.

➤ Bug Number: UDevC00180902. You would receive “Legend Audio Communications” errors 
when editing Edit While Capture clips during an ISIS Block Rectify period. 

➤ Bug Number: UDevC00181609. The AMA_ListPlugins Console Command did not display all 
the digits for AMA Plugins versions. 

➤ Bug Number: UDevC00172844. Select Media Relatives did not deselect unassociated clips if 
the clips were selected before choosing the Select Media Relatives option.

➤ Bug Number: UDevC00180833. The DV25 codec was not available when exporting MXF 
OP1a.

➤ Bug Number: UDevC00180915. Printing a bin in Script View did not print properly.

➤ Bug Number: UDevC00167051. Green lines appeared at the top of the image if you exported 
XDCAM as MXF OP1a. 

➤ Bug Number: UDevC00181829. Logging into Interplay from the Interplay Window Login 
option when in Disconnect Mode resulted in an Access Violation error (Windows) or a 
Segmentation Fault error (Macintosh) and the system would crash. Now, you are not allowed to 
login through the Interplay Window when in Disconnect Mode.

➤ Bug Number: UDevC00169661. AMA linking to XDCAM 50 files created on a Grass Valley 
K2 server could not be sent to playback.

➤ Bug Number: UDevC00180706. With a Nitris DX attached, transcoding performance was slow.

➤ Bug Number: UDevC00172085. Video was not seen on the Record monitor when capturing 
video using IEEE 1394.

➤ Bug Number: UDevC00175241. AIF-C 44.1 OMF audio could not be exported as an AAF 
without generating .new clips.

➤ Bug Number: UDevC00175291. If a sequence from an earlier version of the editing application, 
for example, 4.x was brought into the 6.x version of the editing application, not all audio tracks 
were functional in the Audio Mixer tool.
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➤ Bug Number: UDevC00177614. Legacy P2 and XDCAM import options did not work unless 
the AMA plug-ins were removed.

➤ Bug Number: UDevC00180385. You might have received an “Editor has stopped working” 
error if you imported an XDCAM clip that had a “good shot flag” set in the Sony Content 
Browser.

➤ Bug Number: UDevC00176077. You might have received an Exception error when performing 
an AMA link to an OP1a clip containing a D-track.

➤ Bug Number: UDevC00175764. When the RTAS window was open, the parameters were reset 
if you opened the Digital Cut tool.

➤ Bug Number: UDevC00176982. Auxiliary timecode would reset when an Add Edit was 
applied.

➤ Bug Number: UDevC00181368. Bins were saving slowly if AMA linked clips were on Avid 
Shared Storage.

➤ Bug Number: UDevC00162293. AMA linking to Flip Factory MXF files may have resulted in 
an Exception error.

➤ Bug Number: UDevC00178329. (Symphony) The Tool Palette position would reset if you 
made changes to the Interface Settings.

➤ Bug Number: UDevC00176958. You could not view a quad split in the Source monitor if the 
sequence contained a second video track.

➤ Bug Number: UDevC00178327. The editing application would crash when attempting to 
mount an AMA volume on a shared network drive that was on the same Vlan as the ISIS shared 
storage. 

➤ Bug Number: UDevC00177941.  (NewsCutter) Saving titles in Autotitler in Marquee would 
occasionally save the wrong alpha channel. 

➤ Bug Number: UDevC00178211.  MP4 files did not link or import properly.

➤ Bug Number: UDevC00177416.  You could not render real-time effects when using the Link to 
media option when exporting a Multicam sequence as an AAF.

➤ Bug Number: UDevC00179979.  When AMA linking, Dupe Detection was incorrectly 
identifying clips as duplicates.
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➤ Bug Number: UDevC00178448.  Loading more than 60 AMA H264 QuickTime movies in the 
Timeline would freeze the editing application.

➤ Bug Number: UDevC00177012.  In some instances, XAVC XDCAM media did not link 
correctly.

➤ Bug Number: UDevC00178415, UDevC00175757.  When Printing a bin, items at the bottom of 
the list or to the right side of the page did not print properly.

➤ Bug Number: UDevC00179913.  You might have received a “Sample miscalculation” error 
when imported converted MXF files from Rhozet.

➤ Bug Number: UDevC00181608.  Performing a dual mono audio mixdown resulted in missing 
audio. 

➤ Bug Number: UDevC00178800.  Clicking on the bin lock icon to access the history causes the 
lock icon to disappear.

➤ Bug Number: UDevC00177281.  AMA linked ProRes clips did not consolidate.

➤ Bug Number: UDevC00173311. Changing the color on a group of highlighted clips deselected 
the group.

➤ Bug Number: UDevC00173627. The Record Monitor would appear black after applying a Pan 
& Zoom effect.

➤ Bug Number: UDevC00180280. You could not reformat a native frame rate clip. 

➤ Bug Number: UDevC00179255. Right clicking a sequence containing an alpha channel and 
choosing export might have caused the editing application to crash.

➤ Bug Number: UDevC00180434. (NewsCutter) Duplicate sequence names might have appeared 
in the Record monitor menu.

➤ Bug Number: UDevC00177880. In some instances, when in Trim mode, playing forward or 
backward would display the wrong side of the trim.

➤ Bug Number: UDevC00178453. Adding a column did not automatically generate a .1 version 
of a newly saved Bin View.

➤ Bug Number: UDevC00179943. In some instances, AAF exports failed with linked AMA 
media.
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➤ Bug Number: UDevC00181290. The property value list drop down menu in Assist, Instinct and 
the Interplay Window was empty if Cyrillic or other non 8-bit characters were used in the 
property name.

➤ Bug Number: UDevC00181290. The property value list drop down menu in Assist, Instinct and 
the Interplay Window was empty if Cyrillic or other non 8-bit characters were used in the 
property name.

➤ Bug Number: UDevC00180783.  (NewsCutter) Loading a newly captured clip quickly after 
closing the Capture Tool crashed the editing application while in Capture Mode.

➤ Bug Number: UDevC00181509.  After performing an AAF export and import, the Locator text 
lost its formatting. 

➤ Bug Number: UDevC00181236.  The text for the subclip number did not update and was 
unreadable in the Capture Tool.

➤ Bug Number: UDevC00181610.  In some instances, Media Creation Settings were not sticking.

➤ Bug Number: UDevC00175197.  EDL Manager crashed attempting to create lists from 
auto-synced audio clips in 3D sequences.

➤ Bug Number: UDevC00176500. In some instances, importing IMX30 MXF media did not 
import audio tracks properly.

➤ Bug Number: UDevC00175587. An XDCAM Hi-resolution import would fail if you used a 
different device than was used for the proxy import.

➤ Bug Number: UDevC00180797. Changing the font of Sync Break text in the Timeline did not 
work properly.

➤ Bug Number: UDevC00180610 . You might have received “Disk access” errors when 
importing files with invalid characters into NewsCutter.

➤ Bug Number: UDevC00176433. An aaf was not created on the first attempt. If you tried a 
second time, then it would work.

➤ Bug Number: UDevC00181114. (Macintosh) A shadow layer might have been visible on 
rolling titles.

➤ Bug Number: UDevC00179735. If Dynamic Relink was enabled, checking out clips from the 
Interplay Window could sometimes cause the editing application to get into a “Not responding” 
state.
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➤ Bug Number: UDevC00174589. The drop down menu for workspace names in the Import 
dialog was not wide enough to see the workspace name.

➤ Bug Number: UDevC00174638. You could not batch export audio clips with names longer than 
27 characters.

➤ Bug Number: UDevC00169683. The Source Path was not loaded properly when batch 
importing an ALE file which resulted in an “Invalid FileName” error.

➤ Bug Number: UDevC00170737. (EDL Manager) When sending a drop frame sequence back 
into the editing application, the editing application viewed the sequence as non drop frame.

➤ Bug Number: UDevC00178895. (NRCS) Vertically scrolling Production Cues might have 
covered the Save/Cancel buttons.

➤ Bug Number: UDevC00179198. (NRCS) Moving the horizontal scroll bar resulted in garbage 
characters at the top of the story panel.

➤ Bug Number: UDevC00176337. (NRCS) Changing fonts in the NRCS tool only applied to the 
active story.

➤ Bug Number: UDevC00176339. (NRCS) Selecting a story highlighted all Production Cue text.

➤ Bug Number: UDevC00180010. The Interplay login window did not hide the inserted 
password.

➤ Bug Number: UDevC00177408. Performing a Stereoscopic QuickTime Reference exported 
with effects might have crashed the editing application.

➤ Bug Number: UDevC00177852. In some instances, workspaces with XML files were not 
recognized as valid media file volumes.

➤ Bug Number: UDevC00178679. (Macintosh) Bins saved to the attic were adding an .avb file 
extension to the bin.

➤ Bug Number: UDevC00179541. When performing a Post to Web, the URL placeholder was not 
included in the web xml file.

➤ Bug Number: UDevC00169291. An EDL from a sequence with audio from a stereoscopic clip 
crashed EDL Manager.
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Changed in v6.5.3 and v10.5.3

The following was changed in Avid Media Composer v6.5.3, Avid Symphony v6.5.3, and 
NewsCutter v10.5.3.

Change to AVCHD AMA Plug-In

IMPORTANT: (Windows Only) In previous releases, the AMA AVCHD plug-in had its own 
installer. The plug-in was installed in Program Files\Avid\AVX2_Plug-ins\ AMA\AVCHD. You 
must uninstall the AVCHD plug-in from the Control Panel before you install the 6.5.3/10.5.3 
version of the editing application. Then install the editing application. The AVCHD plug-in will 
get installed to this location: C:\Program Files\Avid \EditorApplicationName\ 
AVX2_Plug-Ins\AMA\AVCHD.

Location Change of QuickTime and AVCHD AMA Plug-In

In order to fix a Co-install issue with Pro Tools, the location of the QuickTime AMA plug-in has 
changed. 

Updated NVIDIA Driver

NVIDIA driver version 310.90 has been qualified with this release.

UDevC00176976 The editing application has qualified NVIDIA driver v310.90. The standard 
configuration requires that the Global preset of the Global Settings for the NVIDIA driver be set 
to “3D App - Video Editing.” However, with this setting, the Marquee Title tool will not launch. 
If you need to use Marquee, set the Global preset to “3D App - Default Global Settings.” If you 
do not use Marquee, keep the Global preset set to “3D App - Video Editing.

Old Location New Location

On a Windows System:

\Program Files\Avid\AVX2_Plug-ins\ 
AMA\QuickTime 

\Program Files\Avid\AVX2_Plug-ins\ 
AMA\AVCHD 

C:\Program Files\Avid \EditorApplicationName\ 
AVX2_Plug-Ins\AMA\QuickTime (Windows)

C:\Program Files\Avid \EditorApplicationName\ 
AVX2_Plug-Ins\AMA\AVCHD (Windows)

On a Macintosh System: 

/Library/Application 
Support/Avid/AVX2_Plug-ins/AMA/MVP_MSP_
Quicktime.avx (Mac)

/Applications/Avid EditorApplication Name
/EditorApplicationName.app/Contents/ 
SharedSupport/AVX2_Plug-Ins/AMA
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Tape ID Character Limit

You can specify a tape ID character limit during Send to Playback. Certain playback systems 
truncate Tape ID names that are too long. This option allows you to set the Tape ID name length. 
Access the Transfer Settings dialog box. Select Tape ID Character Limit and enter a value for the 
Tape ID limit.

Fixed in Media Composer v6.5.3, Symphony v6.5.3, 
and NewsCutter v10.5.3

The following have been fixed:

➤ Bug Number: UDevC00178445. You might have received an “Unsupported format” message 
when exporting XDCAM EX 35 Mbit OP1A.

➤ Bug Number: UDevC00178141. Volume bins did not get updated correctly after performing a 
write back.

➤ Bug Number: UDevC00174819. There might have been audio/video sync issues after 
transcoding ProRes to DNxHD 145.

➤ Bug Number: UDevC00175244. When exporting a QuickTime Reference, “render all video 
effects” ignored the Media Creation Settings. The editing application rendered to the first media 
drive, even if another drive was selected in the Media Creation Settings.

➤ Bug Number: UDevC00177937. Even on an approved system, you could not play 3 streams of 
XDCAM 50 without dropping frames.

➤ Bug Number: UDevC00177498. When a sequence name was in Japanese, you might have 
received errors when exporting a QuickTime Reference movie.

➤ Bug Number: UDevC00179138. On systems with many fonts installed, you could not scroll 
down the font list in the Interface Settings window.

➤ Bug Number: UDevC00178449. The Timeline position indicator would reset if you deselected 
audio tracks.

➤ Bug Number: UDevC00179312. Not all spans across P2 cards appeared in the Volume bin.

➤ Bug Number: UDevC00178555. The Volume bin properties button always displayed AS02 
even if the volume was for another AMA plug-in.
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➤ Bug Number: UDevC00172771. Non-visible blanking areas did not have the correct black 
levels.

➤ Bug Number: UDevC00177543. You might have experienced jumbled edits when importing 
AAFs into Pro Tools that were exported from Media Composer sequences containing mixed 
frame-rate media. 

➤ Bug Number: UDevC00176433. An aaf was not created on the first attempt. If you tried a 
second time, then it would work.

➤ Bug Number: UDevC00175855. Position tracking defaults were incorrect for effects promoted 
to 3D Warp.

➤ Bug Number: UDevC00175594. You might have seen matte key aliasing during full screen 
playback.

➤ Bug Number: UDevC00177210. Performing an Extend edit when in Color Correction mode 
resulted in Access violation errors.

➤ Bug Number: UDevC00176730. With Matrox hardware enabled, you might have received 
“OutputPortController” errors when using the Title Tool.

➤ Bug Number: UDevC00176466. Some handles might have been added when performing a Send 
to Pro Tools resulting in additional transcode.

➤ Bug Number: UDevC00171781. You might have received AMERsourceManager errors when 
toggling between hardware and software mode.

➤ Bug Number: UDevC00165010. Performing a Reveal File did not work for Titles in a bin.

➤ Bug Number: UDevC00176907. The text in a dialog box indicating objects in the bin could be 
opened in earlier versions of the editing application ended in a question mark, causing confusion.

➤ Bug Number: UdevC00176768. NewsCutter ignored the Composer Settings.

➤ Bug Number: UdevC00176592. You might have received an “Exception crumb exists” error 
when deleting an edit that was placed after a marker.

➤ Bug Number: UDevC00176295. In some instances, exporting QuickTime resulted in 
Segmentation fault errors.

➤ Bug Number: UDevC00176015 . Legacy P2 workflow did not work if the P2 Volume had been 
copied to a drive.
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➤ Bug Number: UDevC00175546. XDCAM spanned clips appeared blurred after transcoding 
from 23.98 to 59.94.

➤ Bug Number: UDevC00175216. Opening a bin in Frame View resulted in only some 
headframes visable in the bin.

➤ Bug Number: UDevC00177782 . AMA writeback did not let the AMA plug-in manage the 
volume location.

➤ Bug Number: UDevC00176601 . AudioSuite D-Verb effect parameters did not save properly.

➤ Bug Number: UDevC00177633 . The Audio Mixdown window would not open if there was no 
available bin open.

➤ Bug Number: UDevC00177182 . Extracting a segment from the end of a sequence where there 
was an effect on the Master fader left the sequence length unchanged.

➤ Bug Number: UDevC00171537. Clicking between transitions in Trim mode was slower than in 
previous releases.

➤ Bug Number: UDevC00173790. Full screen playback of the source monitor loaded a black 
frame.

➤ Bug Number: UDevC00178139. The Script window appeared unsaved even after performing a 
Save.

➤ Bug Number: UDevC00177812 . You could not select a local drive for mixdown for Send To 
Playback in a standalone environment.

➤ Bug Number: UDevC00178109 . You could not perform a send to playback if the video was not 
loaded in the monitor.

➤ Bug Number: UDevC00176701 . Linking to Canon H.264 files were offline when Dynamic 
Relink was enabled.

➤ Bug Number: UDevC00177839 . When the original network was not available, saving 
consolidated AMA clips was delayed.

➤ Bug Number: UDevC00178240 . Loading a clip from Interplay into a single Composer window 
resulted in a “Setting Class” error when you closed the window.

➤ Bug Number: UDevC00174451. You might have received a “CompareChunk” error when 
analyzing a track with the NEUGEN LMCorrect plug-in.
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➤ Bug Number: UDevC00178064. Transcoding from XDCAM50 to DNxHD 120 resulted in a 
split image. 

➤ Bug Number: UDevC00173354. If you had a project on an external drive, you could not 
unmount that external drive if Marquee had been opened.

➤ Bug Number: UDevC00174654. On systems with many fonts installed, selecting a font in the 
SubCap effect created a selection window larger than the monitor making it difficult to select a 
font. 

➤ Bug Number: UDevC00171589. (Macintosh) 3D Picture in Picture shifted if you changed the 
Timeline Video Quality setting.

➤ Bug Number: UDevC00177201. Received DIDMapper playback errors with EWC clips has 
been fixed.

➤ Bug Number: UDevC00175228. Performing a Send to Playback with an XDCAM sequence 
with the audio tracks disabled, the audio bit depth was set to 16bit even if the audio was set to 24 
bit.

➤ Bug Number: UDevC00174538. Render times of the LM Correct Loudness plug-in were longer 
than in previous releases.

➤ Bug Number: UDevC00170198. Selecting Alt (Windows) + Render or Option (Mac) + Render 
did not render to the last selected drive.

➤ Bug Number: UDevC00178272. The Audio Project Settings Input tab did not display the 
correct options for the input source.

➤ Bug Number: UDevC00176481. The Title Tool crashed when in an 1080i 59 project.

➤ Bug Number: UDevC00173215. QuickTime “Same as Source” exports were slower if a Nitris 
DX was attached.

➤ Bug Number: UDevC00178471. The Multigroup menu did not populate correctly.

➤ Bug Number: UDevC00174107. (Macintosh) With a Nitris DX attached, you could not output 
LTC and downconvert to SD simultaneously. 

➤ Bug Number: UDevC00173882. The desktop video did not resize to fill the screen on 30” 
monitors.
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➤ Bug Number: UDevC00175090. When changing an effect duration, then pressing the Tab key, 
you might have received a “segmentation fault” or “access violation” error.

➤ Bug Number: UDevC00178961. (AMA) Opening and closing a new volume bin caused P2 
write-back to fail.

➤ Bug Number: UDevC00177886. (Nitris DX) You might have seen an “Exception: 
DoMixSampleFifoToBus” error when playing a sequence with 20 audio tracks to Direct Out.

➤ Bug Number: UDevC00177697. (Macintosh) When running a Japanese locale, the editing 
application crashed if the AirPort option (AirMac) was set in the Video Satellite settings.

➤ Bug Number: UDevC00178447. Adjusting IN/OUT audio pans in Clip Mode did not always 
adjust all the clips from IN to OUT.

➤ Bug Number: UDevC00177282. Exporting a Same as Source QuickTime file with 23.98 media 
in a 59.94 project resulted in a “no valid resolution” error.

➤ Bug Number: UDevC00173454. Adding a Spectramatte effect twice crashed the editing 
application.

➤ Bug Number: UDevC00174465. An Animatte image shifted if you switched between 25 fps 
formats.

➤ Bug Number: UDevC00178653. You might have seen “Assertion failed” errors after checking 
out a sequence from Interplay resulting in a change to the sequence.

➤ Bug Number: UDevC00175264. The Symphony editing application was missing the 15:1s 
resolution.

➤ Bug Number: UDevC00173841. You might have seen quality issues in the background in the 
Title Tool.

➤ Bug Number: UDevC00177242. (Macintosh) PhraseFind did not return search results when 
searching on ISIS. 

➤ Bug Number: UDevC00175197. EDL Manager crashed when creating a list from stereo 3D 
clips.

➤ Bug Number: UDevC00169291. EDL Manager crashed with a sequence containing audio from 
a stereoscopic clip.
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➤ Bug Number: UDevC00178475. (NewsCutter) The NRCS Tool did not h ave a scroll bar on the 
right side of the window.

➤ Bug Number: UDevC00177315. Waves RTAS plug-ins were taking too long to load.

➤ Bug Number: UDevC00149163. (Windows) You could not right-click the Dolby Media Meter 2 
plug-in to add or delete meters.

➤ Bug Number: UDevC00164069. You could not select items from the Alogorithm pulldown 
menu in the Izotope RX2 RTAS plug-in.

➤ Bug Number: UDevC00174393. Some 3rd party RTAS plug-ins caused user-interface errors 
that resulted in AMPI errors.

➤ Bug Number: UDevC00175486. The reformat selection was ignored during a transcode.

➤ Bug Number: UDevC00174079. The button to turn on waveforms was disabled when entering 
locators.

➤ Bug Number: UDevC00174147. (Macintosh) The color picker did not pick the correct color 
when the Record monitor was reduced in size.

➤ Bug Number: UDevC00177612. The NRCS Tool did not display Production Cues if they 
contained Chinese characters.

New in Media Composer v6.5, Symphony v6.5, and 
NewsCutter v10.5

For information on new features, see the What’s New pdf. 

AMA Plug-ins

The AMA QuickTime Plug-in, AS-02 Plug-in and the MXF Plug-in are included with your Avid 
editing application. All other AMA Plug-ins are downloaded and installed separately. See 
www.avid.com/ama.

Audio Device Drivers

For a listing of currently supported Audio device drivers, see  
http://avid.force.com/pkb/articles/en_US/Download/en379411

http://www.avid.com/US/products/Avid-Media-Access
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Before Installing the Editing Application

Read through the Installation Guide for Avid Editing Applications. This document is available on 
the Knowledge Base. 
Important: This is a full version of the editing application. You should uninstall the 
previous build from your system before you install Media Composer or Symphony v6.5.4 
or NewsCutter v10.5.4.

n (Windows) Note for Domain Administrators: If your editing systems are part of a domain, you 
must give the user the right to “Increase Scheduling Priority.” This must be done within the 
Domain Group Policy on the domain controller by giving the right explicitly to the user or giving 
the right to a group and adding the user to that group. You will not be able to launch as a regular 
user if this is not set properly.

Download Note: To avoid “File Path too long” or a “File cannot be copied” warning while 
unzipping the downloaded installer, try placing the installer .zip on the root level of your C:\ 
drive and unzip it from that location.

Notes on Macintosh OS

The Avid editing application Macintosh installer switches to 64-bit. Please make sure that your 
Macintosh system supports 64-bit prior to installing and that your current non-Avid applications 
are compatible to run in 64-bit mode.

Notes on Windows 7 OS

Note the following topics if you are running the editing application on the Windows 7 OS.

Disabling Desktop Compositing

When the Avid editor is launched you might see a dialog box asking you to disable desktop 
compositing. You can disable it without adversely affecting the Avid editing application.

You can choose to disable it and continue with your editing session. The dialog will appear once 
you relaunch the application unless you disable the option.

To disable the desktop compositing:

1. Access the Control Panel.

2. Double-click System.

3. Click Change Settings.
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4. Click the Advanced tab.

5. Under the Performance area, click Settings. 

6. Uncheck “Enable desktop composition.”

The dialog box requesting you to disable desktop compositing does not appear the next time 
you launch the editing application. 

Standard User

You need to first install the editing application as an Administrator. If you are in a Shared 
Storage environment, mount your workspaces as an Administrator. You may then log off and log 
back in as a Standard user, if necessary. 

Notes on Software Licensing

If You Upgrade Your Operating System

If you need to upgrade your operating system after you install your Avid editing application, first 
deactivate your software. After you upgrade your operating system and, if required, reinstall 
your application, you can reactivate your software. For information on activating and 
deactivating your software license, see the Installation Guide for Avid Editing Applications.

Minimum RAM Recommendation

For this release Avid recommends a minimum of 4GB of RAM. Some features might require 
more RAM and specific hardware. See “Feature Performance” on page 37 for more info.

Qualified Hardware and Operating Systems

Some features are processor-intensive and require specific hardware. See “Feature Performance” 
on page 37 for more info.

The following tables provide the information on qualified Windows and Macintosh hardware. 

For 3rd-Party Open IO hardware qualification refer to the manufacturer’s documentation. See the 
Open IO Frequently Asked Questions document on the Knowledge Base: 
http://avid.force.com/pkb/articles/en_US/faq/en422991

http://avid.force.com/pkb/articles/en_US/faq/en422991
http://avid.force.com/pkb/articles/en_US/faq/en422991
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The following tables also list the qualified Operating Systems. Depending upon your hardware 
the qualified Operating Systems are:

• Windows 7 64-bit SP1(Professional)

• (Media Composer and Symphony) Macintosh Lion v10.7.4, 10.7.5, Mountain Lion v10.8.2, 
v10.8.3, 10.8.4

Macintosh OS Permission Information

As of Macintosh OS 10.7 Lion, the default permissions for the root level of the system drive are 
now set to “Read Only” for all users. This prevents the Avid Editing Application from being able 
to use this drive as a media drive. You will see the drive grayed out in Media Creation settings or 
as an option for import, mixdown, render, and consolidate/transcode.

If you don’t intend to use the system drive for media you can leave it alone. This is ideal in most 
cases.

If you do need to use the system drive, perform the following to change permissions.

To change permissions:

1. Click on your system drive (Macintosh HD in most cases) to highlight.

2. From the File menu select Get Info (cmd+I)

3. Click the lock icon in the bottom right to make changes

4. Click on the “Read only” text in the Privilege column next to Everyone and set the privilege 
to “Read & Write”

You should now be able to see the system drive as a valid media drive.

n If you repair permissions on the system drive, they will reset and you will have to repeat this 
procedure.

Macintosh v10.8 and AVCHD

If you are working with AVCHD and have Macintosh v10.8 (Mountain Lion) OS installed in 
your system, the AVCHD folder will appear as a QuickTime icon. You can perform a Link to 
Volume the same as you did when working with Macintosh v10.7, just note that the folder 
appears as a QuickTime icon. When performing a Link to File, you must right+click the AVCHD 
QuickTime icon and select Show Package Contents. Then you can see the BDV folder. Right 
+click the BDV folder and select Show Package Contents. Then you can see the files needed to 
perform an AMA Link to File.
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Qualified PC Workstations with Avid Media Composer, Avid Symphony, 
and Avid NewsCutter

The following PC Workstations are qualified with Avid Media Composer v6 and higher, Avid 
Symphony v6 and higher and NewsCutter v10 and higher.

Qualified PC 
Hardware Graphics Card Qualified OS Supported with 

HP z820 Dual 8 Core 
Intel Xeon E5-2665 2.4 
GHz

NVIDIA Quadro 
4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z820 Dual 6 Core 
Intel Xeon E5-2640 2.5 
GHz

NVIDIA Quadro 
4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Lenovo D30 Dual 6 
core E5-2640 2.5Ghz or 
Dual 8 core E5-2660 
2.2 GHz 16 GB 
DDR3-1600 memory

NVIDIA Quadro 
4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Lenovo C30 Dual 6 
core E5-2640 2.5GHz 
or Dual 8 core E5-2660 
2.2 GHz 16 GB 
DDR3-1600 memory

NVIDIA Quadro 
4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T7600 Dual 8 core 
Intel E5-2665 2.4 GHz 
16 GB DDR3-1600 
memory

NVIDIA Quadro 
4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T5600 Dual 6-core 
Intel E5-2630 2.2 GHz 
16 GB DDR3-1600 
memory

NVIDIA Quadro 
4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Lenovo ThinkStation 
E31, "Intel Xeon 
E3-1245V2 3.40 GHz 
8 GB DDR3-1600 
RAM

NVIDIA Quadro 600 
graphics adapter or 
integrated Intel HD 
Graphics P4000

Windows 7 64-bit Software Only

HP z800 Dual 6 Core, 
2.66 GHz 

NVIDIA
Quadro 4800

Windows 7 64-bit Software Only
Nitris DX
Mojo DX
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HP z800 Dual Quad 
Core, 2.93 GHz or 
2.66GHz

NVIDIA
Quadro 4800

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z420 6-core Intel 
E5-1650 3.2 GHz 8 GB 
DDR3-1600 memory

Quadro 2000 Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Lenovo S30 6-core Intel 
E5-1650 3.2 GHz 8 GB 
DDR3-1600 memory

Quadro 2000 Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T3600 6-core Intel 
E5-1650 3.2 GHz 8 GB 
DDR3-1600 memory

Quadro 2000 Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z400 Single 6 Core 
3.33 GHz

NVIDIA 
Quadro FX 3800
Quadro 2000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP z400 Single Quad 
Core, 3.06 GHz or 2.93 
GHz

NVIDIA
Quadro FX 3800
Quadro 2000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP Z220 Quad Xeon 
E3-1245V2 3.4 GHz 
8 GB DDR3-1600 
memory   (Tower or 
SFF)

Quadro 600

HD4000

Windows 7 64-bit Software Only

Lenovo ThinkCentre 
Edge 92Z  i7-3770S 3.1 
Ghz 8 GB DDR3-1600 
memory     Quad core 
All-in-One

HD4000 Windows 7 64-bit Software Only

HP z210 Quad Core 
Xeon 3.3- E3-1240, 3.4 
E3-1270, 3.5 E3-1280

Quadro 600 Windows 7 64-bit Software Only

HP z200 Intel® Core™ 
i5-660 3.33 4MB/1333 
Dual-Core

NVIDIA 
Quadro 600

Windows 7 64-bit Software Only

Qualified PC 
Hardware Graphics Card Qualified OS Supported with 
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Qualified PC Notebooks for Avid Media Composer, Avid Symphony, and 
Avid NewsCutter

The following PC Notebooks are qualified with Avid Media Composer v6 and higher, Avid 
Symphony v6 and higher and Avid NewsCutter v10 and higher. The following applies to the 
editing system when running on a laptop:

• DNxHD capture is only supported on Mojo DX on a Quad core system with hyperthreading 
enabled. Nitris DX is not supported on laptops.

• Capture of 10 bit video for example, DNxHD 185x, is not supported on Mojo DX.

• Playback in full quality 10 bit mode is not supported

Dell™ T5500 Dual 6 
Core, 2.66GHz

NVIDIA
Quadro FX 4800
Quadro 4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T5500 Dual, 
2.93GHz Quad Core

NVIDIA 
Quadro FX 4800 
Quadro 4000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T3500 Single 6 
Core, 3.2GHz 

NVIDIA 
Quadro FX 3800
Quadro 2000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T3500 Single 
Quad Core, 2.93GHz 

NVIDIA
Quadro FX 3800 
Quadro 2000

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP xw8600 Dual Quad 
Core, 3.0 GHz

NVIDIA 
Quadro FX 3700 

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

Dell T5400 Dual Quad 
Core, 2.5 GHz or 3.15 
GHz

NVIDIA 
Quadro 3700

Windows 7 64-bit Software Only
Nitris DX
Mojo DX

HP xw4600 Core 2 
Duo, 3.0 GHz 

NVIDIA
Quadro FX 570

Windows 7 64-bit Software Only
Mojo DX (No HD capture)

Dell T3400 Core 2 Duo, 
2.33GHz,or 2.66 GHz 

NVIDIA
Quadro FX 570

Windows 7 64-bit Software Only
Mojo DX (No HD capture)

Qualified PC 
Hardware Graphics Card Qualified OS Supported with 
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Qualified PC 
Notebooks Graphics Cards Qualified OS Supported With

Lenovo ThinkPad W530
"Intel Core i7-3720QM 2.6 
GHz, i7-3820QM 2.7GHz, 
i7-3920XM 2.9GHz 

NVIDIA Quadro 
K1000M or 
K2000M 

Windows 7 64-bit Software Only

HP 8770w i7-3720QM 2.6 
Ghz, I7-3820QM 2.7Ghz, 
I7-3920XM 2.9GHz 17" 
1920x1080 - 8 GB 1600MHz 
DDR3 Memory

NVIDIA Quadro 
K3000M or 
K4000M 

Windows 7 64-bit Software Only
Mojo DX

HP 8570w I7-3720QM 
2.6GHz, i7-3820QM 2.7 
GHz 15" 1920x1080 - 8 GB 
1600Mhz DDR3 Memory

NVIDIA Quadro 
K1000M or 
K2000M 

Windows 7 64-bit Software Only
Mojo DX

Dell M6700 i7-3740QM  2.7 
GHz 17" 1920x1080 - 8 GB 
1600Mhz DDR3 Memory

NVIDIA Quadro 
K3000M or 
K4000M 

Windows 7 64-bit Software Only
Mojo DX

Dell M4700 i7-3740QM  2.7 
GHz, 15" 1920x1080 - 8 GB 
1600Mhz DDR3 Memory

NVIDIA Quadro 
K1000M or 
K2000M 

Windows 7 64-bit Software Only
Mojo DX

HP 8760w i7-2820Q, 
i7-2820Q 2.2 or 2.3 GHz

NVIDIA
Quadro 3000M
Quadro 4000M

Windows 7 64-bit Software Only
Mojo DX

HP 8560w, i7-2720Q, 
2820Q, 2.2 or 2.3 GHz
17” 1920 x1080

NVIDIA
Quadro 1000M
Quadro 2000M

Windows 7 64-bit Software Only

Dell M6600, i7-2720Q, 
2820Q, 2.2 or 2.3 GHz
17” 1920 x1080

NVIDIA
Quadro 3000M
Quadro 4000M

Windows 7 64-bit Software Only
Mojo DX

Dell 4600, i7-2720Q, 2820Q, 
2.2 or 2.3 GHz
15” 1920 x1080

NVIDIA
Quadro 1000M
Quadro 2000M

Windows 7 64-bit Software Only
Mojo DX

HP 8740w X820, X920 
Quad i7 (1.73, 2.0 GHz)

17" 1920x1200

NVIDIA FX
2800M

NVIDIA FX
3800M

Windows 7 64-bit Software Only
Mojo DX
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Qualified Macintosh Workstations for Avid Media Composer and Avid 
Symphony

The following Macintosh Workstations are qualified with the Avid Media Composer v6 and Avid 
Symphony v6 and higher. Mac Pro systems ship with the 64-bit kernel enabled. In previous 
releases, you had to toggle to the 32-bit kernel. With v6 and higher, you must run with the 64-bit 
enabled.

HP 8540w X720, X820 
Quad i7 (1.6, 1.73 GHz)

15" 1920x1080

NVIDIA FX
1800M

Windows 7 64-bit Software Only
Mojo DX

Dell M6500 i- 820Q, 
i7-840Q, i7-920X(1.73, 1.87, 
2.0 GHz)

17" 1920x1200

NVIDIA FX
2800M

NVIDIA FX
3800M

Windows 7 64-bit Software Only
Mojo DX

HP 8730 2.53 or 3.06 GHz 
Core 2 Duo

NVIDIA
Quadro FX 2700M
Quadro FX 3700M

Windows 7 64-bit Software Only
Mojo DX (No HD capture)

HP 8530 2.53 or 3.06 GHz 
Core 2 Duo

NVIDIA
Quadro FX 770M

Windows 7 64-bit Software Only
Mojo DX (No HD capture)

Dell 6400 2.53 or 3.06 GHz 
Core 2 Duo

NVIDIA
Quadro FX 2700M
Quadro FX 3700M

Windows 7 64-bit Software Only
Mojo DX (No HD capture)

Qualified PC 
Notebooks Graphics Cards Qualified OS Supported With

Qualified Macintosh 
Hardware Graphics Cards Qualified OS Supported With

Mac Pro “Westmere” 
Two 2.66GHz 6-Core 
Intel Xeon (12 cores) 

ATI Radeon HD 5770 Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only
Nitris DX
Mojo DX

Mac Pro “Nehalem” 
2.66 GHz or 2.93 GHz 
Dual Quad Core Intel 
Xeon 

NVIDIA GeForce 
GT 120

Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only
Nitris DX
Mojo DX

http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
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Mac Pro “Nehalem” 
Dual 2.26 GHz Quad 
Core Intel

NVIDIA GeForce GT 
120

Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only

Mac Pro “Harpertown” 
Dual Quad Core 3.0 or 
3.2 GHz

NVIDIA GeForce 
8800 GT

Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only
Nitris DX
Mojo DX

iMac 27” Display Quad 
Core 3.4 GHz

ATI 6970M Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only

iMac 27” Display Quad 
Core 2.93 GHz

ATI 4850 Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only

iMac 21.5” Display 
Dual Core 3.6GHz

GeForce 9400 Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only

iMac 27” Display 
2.8 GHz 4 GB Quad 
Core 1066MHz

ATI Radeon HD 4850 
Graphics Processor

Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only

iMac 27” Display Quad 
Core 2.8GHz

ATI 4850 Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only

Qualified Macintosh 
Hardware Graphics Cards Qualified OS Supported With

http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
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Qualified Macintosh Notebooks for Media Composer and Avid Symphony

The following Macintosh notebooks are qualified with the current editing applications. The 
following applies to the editing system when running on a laptop.

• HD Capture on Macintosh notebooks is not supported

• Playback in full quality 10 bit mode is not supported

iMac 20” Display 
2.66 GHz Core 2 Duo

GeForce 9400 Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only

Qualified Macintosh 
Hardware Graphics Cards Qualified OS Supported With

Qualified Macintosh 
Notebook Graphics Cards Qualified OS Supported With

Mac Mini Server 2.0 GHz i7 Quad 
core Thunderbolt - 4GB 
1333MHz DDR3

Intel 
3000

Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only

MacBook Air 13"  - 2.0 GHz I7 
Dual-Core Thunderbolt - 8 GB 
1600MHz DDR3L

Intel HD4000 Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only

MacBook Air 13” 
1.7GHz Dual-Core Intel Core i5 
or 
1.8GHz Dual-Core Intel Core i7

Intel 
3000

Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only

MacBook Pro 15" 2.3/2.6/2.7 
GHz I7 Quad-Core - Retina & 
Thunderbolt

8 GB 1600Mhz DDR3L Memory

HD4000

GeForce GT 650M

Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only

http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
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Compatibility Chart

The following table lists the NVIDIA® driver, QuickTime®, Windows Media™, shared storage, 
Sony® XDCAM™, Panasonic® P2, and Pro Tools LE® versions that were qualified with the Avid 
editing applications. Also listed are the third-party applications such as Boris Continuum 
Complete, Avid DVD by Sonic™, and Sorenson Squeeze®. 

MacBook Pro 17" 
2.2/2.3/ GHz Quad Core i7

6750M
Intel 
3000

Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only

MacBook Pro 15" 
2.0/2.2/2.3GHz Quad Core i7

6490M
6750M
Intel 
3000

Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only

MacBook Pro 15" 
2.53GHz Dual Core i5
15” or 17” 2.66GHz Dual Core i7

GT 330M Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only
17” only - Mojo DX (no 
DNxHD capture)

MacBook Pro 15” or 17” 
2.53/2.66/2.8 GHz Core 2 Duo

 9400M and 9600M Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only
Mojo DX (no DNxHD capture)

MacBook Pro 15” and 17” 
2.5 GHz Core 2 Duo

 8600M Lion v10.7.4, 
10.7.5
Mountain Lion 
v10.8.2, v10.8.3, 
v10.8.4

Software Only
Mojo DX (no DNxHD capture)

Qualified Macintosh 
Notebook Graphics Cards Qualified OS Supported With

Item Versions Comments

QuickTime Support v7.7.3 (Windows)
v10.x, (v7.x legacy) (Macintosh)

Note: QuickTime v10X does not include 
QuickTime Pro options.

http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=375771
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Windows Media 
Version Support

Windows Media Player 12 (for 
Windows 7)

If you do not have Windows Media 
Player, access the download at 
www.microsoft.com.

Windows Media export compatibility is 
subject to Microsoft Windows Media 
updates.

Avid Interplay 
Support

See the Knowledge Base article 
“Interplay and Avid Editor 
Compatibility.”

IMPORTANT: The Avid Interplay 
components that get installed on the 
editing application must be updated to 
the Avid Interplay version that is released 
with the editing application. These 
include the Media Indexer, Interplay 
Access, Interplay Framework, Interplay 
Transfer Client and ProEncode Client. 
The Avid Interplay Server components 
can remain on the previous releases listed 
as supported. For details, see the “Avid 
Editing Application Compatibility with 
Interplay Releases” topic in the Avid 
Interplay ReadMe.

NVIDIA Driver 
Support

v310.90 See Setting up the NVIDIA Card.
For setting up the driver for stereoscopic, 
see the NVIDIA setup info in the 
Stereoscopic 3D Workflow Guide.

Shared Storage 
Support

Avid Unity™ MediaNetwork and 
Avid Unity ISIS®.

See “Shared Storage Support” on 
page 36.

Item Versions Comments

http://www.microsoft.com/en/us/default.aspx
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Pro Tools • For information on supported 
versions of Pro Tools in an Interplay 
environment, see the Avid Interplay 
ReadMe or 
http://avid.custkb.com/avid/app/selfs
ervice/search.jsp?DocId=353977&Hi
lite=Pro+Tools+Interplay

• For Co-install information, see Avid 
Editing Application Compatibility 
with Pro Tools.

• For Video Satellite information, see 
the Video Satellite Guide or 
http://avid.custkb.com/avid/app/selfs
ervice/search.jsp?DocId=354337&Hi
lite=video+satellite

Sony XDCAM 
driver

v2.13 (XDCAM Transfer for 
Macintosh)

Win 7-64 FAM 2.3.2 and VFAM 
4.0.1

The VFAM firmware version is 2.45. The 
driver can be downloaded from Sony's 
website http://esupport.sony.com/.

Panasonic P2 drive (Macintosh) No device support 
for Lion

(Windows 7) Driver version for 
P2 devices:v2.16

There is currently no P2 writeback 
support for Macintosh clients.

Boris Continuum 
Complete

v8.1 Ships with:
Avid Symphony™ 

Avid DVD by Sonic v6.4.4 Ships with:
Avid Media Composer
Avid Symphony
Avid NewsCutter

Sorenson Squeeze v8.1 Ships with:
Avid Media Composer
Avid NewsCutter
Avid Symphony

Avid FX v6.0.6 (Windows)

v6.0.6 (Macintosh)

Ships with:
Avid Media Composer
Avid Symphony 
Avid NewsCutter

Item Versions Comments

http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=353977&Hilite=Pro+Tools+Interplay
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=353977&Hilite=Pro+Tools+Interplay
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=353977&Hilite=Pro+Tools+Interplay
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=354337&Hilite=video+satellite
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=354337&Hilite=video+satellite
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=354337&Hilite=video+satellite
http://esupport.sony.com/
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Avid Editing Application Compatibility with 
Pro Tools

General Co-Installation Notes:

• Install Pro Tools first and then Media Composer.

• You must uninstall all older versions of Media Composer or Pro Tools before installing 
newer versions.

• Co-install does not support both applications launched simultaneously.

• When you uninstall Pro Tools, choose to uninstall just the application and not the audio 
drivers or the editing application no longer sees the devices. On a Macintosh Pro Tools 
system, this is named the “Safe Uninstall.” On a Windows Pro Tools system, you must select 
the first uninstall option — “Pro Tools Only” — which is not selected by default.

• (Macintosh only) When you uninstall your Avid editing application, you must uninstall just 
the application and not the audio drivers or Pro Tools no longer sees the devices. When you 
start the Avid Uninstaller, deselect the options to uninstall AvidCoreRuntime.pkg and 
AvidDIORuntime.pkg.

• Mojo SDI will not be supported with Media Composer, but can still be connected in a 
co-install configuration for use with Pro Tools.

• If you install and configure Avid Mojo DX or Nitris DX hardware on your system, the 
editing application does not use any connected Pro Tools audio device for audio input/output 
operations. You can also use these audio devices with a software-only version of your Avid 
editing application (Media Composer and NewsCutter).

• If you run into any issues, uninstall both applications and reinstall Pro Tools first, and then 
reinstall your editing application.

• Media Composer v5.0 and later and Pro Tools v8.0.3 and later do not include support for the 
Original Mbox. If you want to use the Original Mbox, you should use Media Composer v4.x 
and Pro Tools v8.0.1 instead.

• If you want to install your Avid editing application on a system with the Pro Tools Avid 
Video Engine installed, you must use one of the following configurations:

- Media Composer v5.5/NewsCutter v9.5 and later with Pro Tools v9.0 or later.

- Media Composer v5.0.x/NewsCutter v9.0.x with Pro Tools v8.5 or earlier.

Avid Artist Series 
(Euphonix)

EuControl software v2.6.2 or later See the User’s Guide for information on 
Artist Series Color setup information.

Item Versions Comments
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Co-installation Configurations and Audio Device 
Support

Avid Pro Tools Applications

Avid Mbox Family Audio Devices (3rd Generation)

Avid Mbox 2 Family Audio Devices

Pro Tools 
Product

MC/NC 
Software 
Only

MC/NC 
with Mojo 
DX

MC/NC/
Symphony 
with Nitris DX

Pro Tools 
Software Only

Co-install Co-install Co-install

Pro Tools|HD 
Native

Co-install/
Audio Device

Co-install Co-install

Pro Tools|HD Co-install/
Audio Device

Co-install Co-install

Pro Tools|HD, 
with chassis

Not Tested Not Tested Not Tested

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
Symphony 
with Nitris DX

Mbox 
(USB)

Co-install/
Audio Device

Co-install Co-install

Mbox Pro Co-install/
Audio Device

Co-install Co-install

Mbox Mini 
(USB)

Co-install/
Audio Device

Co-install Co-install

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
Symphony 
with Nitris DX

Mbox 2 
(USB)

Co-install/
Audio Device

Co-install Co-install
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Other Avid Audio Devices

External Controllers
Your Avid editing application supports the following external fader controllers or mixers for 
automation gain and pan recording or as control surfaces:

• Digi 002 (Windows only — Media Composer and NewsCutter)

• Command|8

• Avid Artist Control

• Avid Artist Mix

• Avid Artist Transport

Mbox 2 Pro 
(1394)

Co-install Co-install Co-install

Mbox 2 
Mini (USB)

Co-install/
Audio Device

Co-install Co-install

Mbox 2 
Micro 
(USB)

Co-install Co-install Not tested

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
Symphony 
with Nitris DX

Audio 
Device 
(Interface)

MC/NC 
Software 
Only

MC/NC with 
Mojo DX

MC/NC/
Symphony 
with Nitris DX

Digi 002 
(1394)

Co-install/
Audio Device 
(Windows)

Co-install Co-install

Digi 003 
(1394)

Co-install Co-install Co-install

Eleven Rack 
(USB)

Not Supported Not Supported Not Supported

Fast Track 
Pro (USB)

Audio Device Not Supported Not Supported
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• Avid Artist Color

• JL Cooper MCS-3000X MIDI automation controller

• JL Cooper FaderMaster Pro MIDI automation controller

• Yamaha® 01V/96 and Yamaha 01V digital mixing console

n The JL Cooper controllers and Yamaha mixing consoles do not support automation pan 
recording.

External controllers or mixers are optional. They are not required for you to perform automation 
gain or pan recording on an Avid editing system.

The following table compares Avid external controllers and mixers.

Feature
Digi 002 
(MC/NC only) Command|8

Avid Artist 
Control

Avid Artist 
Mix

Avid Artist 
Transport

Avid Artist 
Color

Control surface 
for transport 
controls and 
other functions

Yes Yes Yes Yes 
(transport 
only, no soft 
keys)

Yes

Provides audio 
play, input, and 
output

Yes No No No No

Record 
automation gain

Yes Yes Yes Yes No

Record 
automation pan

Yes Yes Yes Yes No

Flying faders Yes (8) Yes (8) Yes (4) Yes (8) No

Touch-sensitive 
faders

Yes Yes Yes Yes No

Touch-sensitive 
panners

No No Yes Yes No

Solo/mute Yes Yes Yes Yes No

Supports audio 
mixing

Noa No No No No

Latch mode 
(also known as 
Snap mode)

Yes Yes Yes Yes No
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The following table compares supported third-party external controllers and mixers.

For more information on using these external fader controllers or mixers, see “Recording 
Automation Gain or Automation Pan Information” in the Help.

Number of 
steps of fader 
accuracy

1024 1024 1024 1024 Not applicable

a. The Digi 002 can be used as a standalone audio mixer but not at the same time as it is being used as an automation gain or 
automation pan controller or control surface.

Feature
Digi 002 
(MC/NC only) Command|8

Avid Artist 
Control

Avid Artist 
Mix

Avid Artist 
Transport

Avid Artist 
Color

Feature FaderMaster Pro MCS-3000X Yamaha 01V/96 and Yamaha 01V

Control surface for transport 
controls and other functions

No No No

Provides audio play, input, and 
output

No No No

Record automation gain Yes Yes Yes

Record automation pan No No No

Flying faders No Yes Yes

Touch-sensitive faders No Yes No

Solo/mute Yes Yes Yesa

a. For Yamaha fader/controllers, solo works only if you do not use the unit for audio mixing at the same time

Supports audio mixing No No Yes

Latch mode (also known as 
Snap mode)

No Yes No

Number of fader steps of 
accuracy

128 1024 256
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Setting up the NVIDIA Card

To set up the NVIDIA card, you must make sure you have the correct display driver version 
(install the display driver if necessary, and set the correct display settings. This version of the 
editing application requires the following Nvidia Driver: v310.90 

Prior to setting up the NVIDIA card, check to make sure you have the correct display driver 
version. If you do not have the correct NVIDIA driver, you can install it from the Utilities folder 
that installs with your Avid application.
Installation files for these drivers are installed in the folder Program Files\Avid\Utilities\nVidia.

To check the NVIDIA display driver version:

1. Right-click the Desktop and select NVIDIA Control Panel. You can also open the Windows 
Control Panel and double-click the NVIDIA Control Panel icon.

2. Click System Information at the bottom left corner of the NVIDIA Control Panel.

The version number is listed in the Graphics card information section on the ForceWare 
version line.

To install the NVIDIA display driver:

1. Navigate to Program Files\Avid \Utilities \nVidia and double-click the folder that 
corresponds to your operating system.

2. Double-click the file for the applicable driver.

3. Follow the on-screen instructions, and then restart your system.

To setup multiple displays:

1. Right-click the Desktop, and select Nvidia Control Panel. 

2. In the settings window in the left of the window, click Set up multiple displays.

3. Select or deselect the desired monitors listed.

To set Desktop Video Editing Mode:

1. Right-click the Desktop, and select Nvidia Control Panel. 

2. In the menu bar, select Desktop. Enable Desktop>Video Editing Mode.

3. Click Apply.

To set the Prefer Maximum Performance mode and Global Settings:

1. Right-click the Desktop, and select Nvidia Control Panel.

2. Click Manage 3D Settings.

3. Set Global presets to Base profile.
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4. In the Global Settings tab, change Power Management mode to Prefer Maximum 
Performance.

5. Click Apply.

6. Set the Global preset to 3D App-Video Editing.

7. Click Apply.

Reboot after installing the Nvidia software even if you are not prompted to do so. 
Never use the Windows “roll back driver” feature on the Nvidia driver. The driver version must 
match the rest of the components the Nvidia installer installs.

Shared Storage Support

The editing application has been tested in a shared storage environment with the following.

There is no support for ethernet attached clients in a MediaNetwork environment.

Editing 
Application 
Operating 
System

ISIS 
Clients

ISIS 
5000 
Server

ISIS 
2000 
Server

ISIS 
7000 
Server

Media-
Network 
Client

Media-
Network 
Server

Windows 7 64-bit  v4.0, 
v4.2

v3.2, 
v4.0, 
v4.0.1, 
v4.0.3

v4.1, v4.2  v2.4. v4.0, 
v4.0.1, v4.0.3

v5.4 v5.1.3

Macintosh Lion 
v10.7.3

 v.4.0, 
v4.2

v3.2, 
v4.0, 
v4.0.1, 
v4.0.3

v4.1, v4.2 v2.4., v4.0, 
v4.0.1, v4.0.3

v5.5.1 v5.1.3

Macintosh 
Mountain Lion 
v10.8.x

4.2 v3.2, 
v4.0, 
v4.0.1, 
v4.0.3

 v4.1, v4.2  v2.4., v4.0, 
v4.0.1, v4.0.3

not 
supported

 not 
supported
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Feature Performance

A number of features in this editing application are processor-intensive. As a result, you might 
experience problems if you are working on an older system. The following chart shows the 
hardware that Avid has successfully qualified when using these features. 

Feature Description Recommended System

J2K Capture • HP z820 Dual 6 Core or Dual 8 Core

• Lenovo D30 Dual 6 Core or Dual 8 
Core

• Lenovo C30 Dual 6 Core or Dual 8 
Core 

• Dell T7600 Dual 8 Core or Dual 6 
Core

• HP z800 Dual 6 Core

• Dell T5600 Dual 8 Core or Dual 6 
Core

• Dell T5500 Dual 6 Core 

• Mac Pro Dual 6 Core “Westmere”
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Stereoscopic 3D For optimal performance with 
Stereoscopic 3D, use these higher 
performance systems. Avid 
recommends a minimum of 12GB 
RAM when using Stereoscopic 
3D.

• HP z820 Dual 6 Core or Dual 8 Core

• Lenovo D30 Dual 6 Core or Dual 8 
Core

• Lenovo C30 Dual 6 Core or Dual 8 
Core

• Dell T7600 Dual 8 Core or Dual 6 
Core

• HP z800 Dual Quad Core, or Dual 6 
Core

• Dell T5600 Dual 8 Core or Dual 6 
Core

• HP z400 Single 6 Core

• HP z420 Single 6 Core

• Dell T3500 Single 6 Core

• Dell T3600 Single 6 Core

• Dell T5500 Dual, 2.93GHz Quad 
Core

• Mac Pro Dual 6 Core “Westmere”

Feature Description Recommended System
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XDCAM HD50 Capture Baseband capture through Nitris 
DX, Mojo DX

• HP z820 Dual 6 Core or Dual 8 Core 

• Lenovo D30 Dual 6 Core or Dual 8 
Core

• Lenovo C30 Dual 6 Core or Dual 8 
Core 

• Dell T7600 Dual 8 Core or Dual 6 
Core

• HP z800 Dual Quad Core or Dual 6 
Core

• Dell T5600 Dual 6 Core Dual 8 Core

• HP z420 Single 6 Core

• HP z400 Single 6 Core

• Dell T3600 Single 6 Core

• Dell T3500 Single 6 Core

• Dell T5500 Dual, 2.93GHz Quad 
Core 

• Mac Pro Dual Quad Core “Nahalem” 
or Dual 6 Core “Westmere”

HD RGB 4444
ProRes 4444
DNxHD 4444

HD RGB capture requires a high 
end workstation with Nitris DX 
and fast storage. (The HP z800 
and the Dell T5500 have been 
qualified to successfully play 
back 2 streams with PIP and 
Color Correction effects. The Mac 
Pro Dual Quad Core “Nahalem” 
successfully plays back 2 streams 
with PIP.)

• HP z820 Dual 6 Core or Dual 8 Core

• Lenovo D30 Dual 6 Core or Dual 8 
Core

• Lenovo C30 Dual 6 Core or Dual 8 
Core 

• Dell T7600 Dual 6 Core or Dual 8 
Core

• HPz800 Dual Quad Core or Dual 6 
Core

• Dell T5600 Dual 6 Cor or Dual 8 
Core

• Dell T5500 Dual, 2.93GHz Quad 
Core 

• Mac Pro Dual Quad Core “Nahalem” 
or Dual 6 Core “Westmere”

• Storage: 10Gb Ethernet ISIS, 

Feature Description Recommended System
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AMA (RED) AMA is a processor intensive 
operation. Older platforms may 
not offer optimum performance.

• HP z820 Dual 6 Core or Dual 8 Core 

• Lenovo D30 Dual 6 Core or Dual 8 
Core

• Lenovo C30 Dual 6 Core or Dual 8 
Core 

• Dell T7600 Dual 8 Core

• HP z800 Dual Quad Core, or Dual 6 
Core

• Dell T5600 Dual 6 Core

• HP z420 Single 6 Core

• HP z400 Single 6 Core

• Dell T3600 Single 6 Core

• Dell T3500 Single 6 Core

• Dell T5500 Dual, 2.93GHz Quad 
Core

• Mac Pro Dual Quad Core “Nahalem” 
or Dual 6 Core “Westmere”

AMA (QuickTime) AMA is a processor intensive 
operation. Lower end platforms 
may not offer optimum 
performance. Highly compressed 
codecs such as H.264 will exhibit 
minimal real-time performance. 

Recommendation of qualified systems 
depends on your planned use of this 
feature. Heavy usage of highly 
compressed codecs requires the high end 
systems. (Dual 6 Core or Dual 8 Core 
systems)

DVCPro HD capture You will get better performance 
with a dual quad core or dual 
6-core system.

Dual Quad Core, Dual 6 Core or Dual 8 
Core Systems

AVCI-Intra AVC-Intra(AVC-I) is a high 
quality, low bit-rate HD codec and 
is very CPU intensive. 

4-Way MultiCam Playback

Dual Quad Core, Dual 6 Core or Dual 8 
Core Systems

Four Stream Playback:

Dual Quad Core, Dual 6 Core or Dual 8 
Core Systems

Feature Description Recommended System
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Limitations

The following limitations apply to the current version of the editing application.

Avid Artist Color

➤ Bug Number: UDevC00157064. Some soft keys do not light up when you use the Avid Artist 
Color with your Avid editing application, including the following:

• HSL Shift Layer: all soft keys

• HSL Bank 2 Shift Layer: all soft keys

• Curves: F8 and F9 soft keys

• Curves Shift: F1, F3, F6, and F9 soft keys

• Secondary: F2, F7, F8, and F9 soft keys

• Secondary Shift: all soft keys

The soft keys listed above function normally even when they do not light up.

➤ Bug Number: UDevC00163957. Hue offset color wheels might not appear when you use Artist 
Color to enter Color Correction mode the first time after start your Avid editing application. Any 
parameter update will draw them.

Workaround:  When you make any change in a parameter in the Color Correction tool, the 
color wheels appear.

➤ Bug Number: UDevC00156948.  (The F2 soft key (Next HSL Subtab) does not function until 
after you apply a color correction to your footage. If you press F2 (Next HSL Subtab) on the 
Artist Color surface before you apply a color correction, you get a system beep and the subtab 
does not change.

➤ Bug Number: UDevC00157932. If you use the HSL shift control for trackballs, you might see 
the trackballs controlling the wrong monitor during shuttle. For example, if you press Shift and 
then use the right trackball to shuttle, and then move either the left or the center trackball, you 
might see the other trackballs now control the right monitor. 

➤ Bug Number: UDevC00164772. When you first ope n the Color Correction tool, either with the 
Artist Color or with the mouse, incorrect color correction values might display in parameter 
fields. This problem is intermittent, and it does not occur after you change a parameter value.

Workaround:  Adjust any parameter. The correct values display in the Color Correction tool.
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➤ Bug Number: UDevC00164954. (Macintosh only): The EuControl application does not open 
when you select Edit Settings in the Controller Settings dialog box. To configure your EUCON 
device, you must open the EuControl application by clicking the EUCON icon in the dock, and 
then selecting Window > EuControl Settings.

Compatibility

➤ Bug Number: UDevC00166431. You might receive AMPI Subsystem errors when launching 
the editing application. Avid recommends that you refer to the following Knowledge Base article 
for information on possible causes.
http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=377091

➤ Bug Number: UDevC00151588. You must have the MediaNetwork client installed on your 
system in order to play linked AMA clips from the MediaNetwork shared storage.

➤ Bug Number: . The Standalone Transfer Manager will be supported with this release, except for 
compatibility with Airspeed Classic and Open I/O devices.

Effects

➤ Bug Number: . AVX 1 effects are no longer supported and will not be recognized in this latest 
version of Media Composer. Please contact the respective 3rd-party plug-in vendor for an AVX2 
64-bit version of any existing plug-in that you might have purchased. The following Avid AVX1 
effects will automatically be promoted to AVX2:

• Avid Pan & Zoom

• Region Stabilize

• RGB Keyer

When you load a previously-generated sequence containing one of these effects, they will 
automatically be promoted to new corresponding AVX2 effects. These effects will not be 
recognized by earlier versions of Media Composer.

➤ Modifying Pan Values in the Timeline: You can display different pan values in the Timeline for 
different audio tracks by clicking the Clip Gain/Pan button in the Track Control panel and 
selecting one of the pan value options. However, if you want to manipulate pan control points 
(either adding a keyframe or adjusting a keyframe), you must make sure all audio tracks display 
the same pan values. To do this, Alt+click the Clip Gain/Pan button in the Track Control panel 
for any audio track and select a pan value option.

http://avid.custkb.com/avid/app/selfservice/search.jsp?DocId=377091
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Interplay

➤ Interplay v.2.5 support for native HD 23.976p and HD 24p formats now includes their associated 
proxy resolutions. For more information refer to the Avid Interplay Best Practices Guide.

➤ Bug Number: . (Interplay) Dynamic relink is not currently supported for media that requires 
pulldown. Therefore, you can only use it with clips where the media has been acquired at the 
native frame rate (without pulldown).

➤ Bug Number: . (Interplay) Pro Res formats can only be used by Avid editing applications that 
are in a non-Interplay environment. For any additional limitations regarding running an Avid 
editing application in an Interplay environment, see the Interplay ReadMe.

➤ Bug Number: UDevC00164931. (Avid Interplay and Windows 7) Can't locate Media Indexer 
on Avid editor after first install. After an initial installation of the editor and Interplay support 
software, the editing application may fail to locate the Media Indexer. This can happen if some of 
the Avid Service Framework services have not started correctly.

Workaround:  Open the Workgroup Properties tool on the editor and check whether any of the 
services are not running. Restart any services as required. Then restart the Avid editing 
application again. You may have to do this the first few times that you start the editor. After a few 
times the services will begin starting automatically, even after a reboot.

Media Tool

➤ Bug Number: UDevC00164836. If the Media Tool window is set to Frame view, you might 
experience slow redraw issues when accessing large volumes of shared storage.

Output

➤ You cannot control down/cross conversion from the Video Output Tool when in TrueP mode for 
1080p projects or when you are in Stereoscopic mode.

Workaround:  When in stereoscopic mode or have True Progressive output set for 1080p 
projects, the down-convert and cross-convert options are not available. To output at a rate 
different than the project format, go to the Format tab and change the output project setting.

PhraseFind

➤ Bug Number: UDevC00166649. For best results with PhraseFind, Avid recommends using 
Avid certified storage solution.
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Play

➤ Bug Number: UDevC00164987. After editing for an extended period of time, using the 
keyboard arrow keys to single step through the sequence might skip frames or move in the wrong 
direction. 

Workaround:   Minimize and maximize the editing application or change focus to another 
application and then back to the editor.

➤ Bug Number: UDevC00153838. You might receive an “Exception: The sequence or one of its 
source elements is too long to be played” error if you have a sequence over 12 hours.

QuickTime

➤ Bug Number: UDevC00159820. QuickTime Reference movies are not supported by 
QuickTime Player X. They are still supported in QuickTime Player 7 on the Macintosh. They are 
also not supported in QuickTime version 7.6.9 on Windows.

Stereoscopic 3D

➤ A software developer's kit is now available for 3rd-party partners who would like to build AMA 
plug-ins, AVX2 effects, or develop applications that support stereoscopic 3D media/sequences 
compatible with Avid Media Composer or Symphony. This developer's kit is available on the 
Avid website.

➤ 720p Stereoscopic projects are not currently supported with Open I/O hardware from 3rd-party 
vendors.

➤ Bug Number: UDevC00164741. If a rolling title is used in an Over\Under stereo project, you 
may get the wrong scaling and cropping of lines.

➤ Stereoscopic projects are not supported on Avid Interplay.

➤ Multicam of stereoscopic clips is not supported. 
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➤ NVIDIA 3D Vision

• Avid currently only supports the NVIDIA 3D Vision Home bundle (which includes the 3D 
glasses, emitter hub and display monitor). The 3D Vision Pro has not been successfully 
tested.

• Full screen playback on an NVIDIA 3D Vision monitor is only supported on a Windows 
system.

• Due to an NVIDIA driver issue, the first time that the full screen play window appears, the 
application will resize to a single monitor. Resize the application as necessary. You can reset 
your window positions by clicking on a toolset in the menu.

➤ Bug Number: UDevC00161499. Ancillary data output is not supported if you are working in 
full stereoscopic format.

Timeline

➤ Bug Number: UDevC00164751. If you have a sequence loaded in the Timeline, and you have 
waveforms on, clicking or dragging in the Timeline does not stop the waveform from drawing. 

Workaround:  Hold Cmd + . to stop the waveform from drawing. 

User Interface

➤ Bug Number: UDevC00162819. You cannot copy and paste timecode values into the Source or 
Record monitors. To enter timecode in the monitors, select the monitor and then type in the 
appropriate timecode values.

➤ Bug Number: UDevC00164678. You can drag audio keyframes past adjacent audio keyframes. 
Moving an audio keyframe past another keyframe causes the keyframes to swap values. For 
example, set volume levels on two audio keyframes: Keyframe A for low volume (left keyframe) 
and Keyframe B for high volume (right keyframe). If you then drag Keyframe A to the right of 
Keyframe B, Keyframe A now displays the higher volume level. 

➤ Bug Number: UDevC00164995. (Macintosh only) If you load a group clip into the Source 
monitor while in MultiCamera mode, the monitor displays the clip as if MultiCamera mode is 
still selected, although the action of loading the group clip actually causes the Avid editing 
application to enter Source/Record mode. If you play back the clip, you only see the linecut and 
cannot perform MultiCamera edits.

Workaround:  To turn off the Multicamera mode display, select Special > Multicamera Mode, 
and make sure MultiCamera Mode is not selected.
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➤ Bug Number: UDevC00165159. (Macintosh only) If you render a sequence containing a title 
by selecting Clip > Render In/Out or by right-clicking the sequence and selecting Render In/Out, 
the progress bar displaying the status of the render operation does not update and the application 
appears to become unresponsive. However, even though the progress bar does not advance, the 
rendering operation continues. When it completes, the progress bar closes.

Documentation Changes

The following documentation changes were made after the initial documentation release was 
finalized. These will be corrected in the next release of the product. 

Lassoing Segments in NewsCutter

When selecting a segment in the NewsCutter editing application Timeline, drawing a lasso from 
left to right selects the segment. If you have the Keyframe Selection tool enabled, drawing a 
lasso from left to right, selects the audio keyframes within the segment.

n Disable the Keyframe Selection Tool to enable selecting segments.

Committing Assets to an Export Volume

In the What’s New for v6.5, the topic “Committing Assets To an Export Volume” should have 
stated that once you commit the assets, the sequence is flattened to the OP1b format, the video is 
encoded to the codec set in the selected shim and audio saved as PCM. 
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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including 
photocopying and recording, for any purpose without the express written permission of Avid Technology, Inc.

Copyright © 2013 Avid Technology, Inc. and its licensors. All rights reserved.

Portions © Copyright 2003-2007 of MOG Solutions.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a 
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the 
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192XD I/O, 888 I/O, AirPlay, AirSPACE, AirSPACE HD, AirSpeed, ALEX, Alienbrain, AniMatte, AudioMarket, 
AudioPages, AudioSuite, AudioVision, AutoSync, Avid, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid DNxHD, AVIDdrive, 
Avid DS Assist Station, Avid EditStar, Avid Learning Excellerator, Avid Liquid, Avid Liquid Chrome Xe, Avid MEDIArray, Avid Mojo, 
AvidNet, AvidNetwork, Avid NewStar, Avid Remote Response, AVIDstripe, Avid Unity, Avid Unity ISIS, Avid VideoRAID, 
Avid Xpress, AVoption, AVX, Beauty Without The Bandwidth, Boom, C|24, CaptureManager, ChromaCurve, ChromaWheel, 
Command|24, Conectiv, CountDown, DAE, Dazzle, Dazzle Digital Video Creator, Deko, DekoCast, D-Fi, D-fx, DigiDelivery, 
Digidesign, Digidesign Audio Engine, Digidesign Intelligent Noise Reduction, DigiDrive, DigiLink, DigiMeter, DigiSerial, DigiStudio, 
DigiStudio Control, Digital Nonlinear Accelerator, DigiTranslator, DINR, DNxchange, do more, DVD Complete, D-Verb, Eleven, 
Equinox, EveryPhase, ExpertRender, Fastbreak, Fast Track, FieldPak, Film Composer, FilmScribe, Flexevent, FluidMotion, FXDeko, 
G7, G-Rack, HD Core, HD Process, HDPack, HYBRID, HyperControl, HyperSPACE, HyperSPACE HDCAM, IllusionFX, 
Image Independence, iNEWS, iNEWS Assign, iNEWS ControlAir, Instantwrite, Instinct, Intelli-sat Broadcasting Recording Manager, 
Intelli-Sat, InterFX, Interplay, inTONE, Intraframe, iS9, iS18, iS23, iS36, ISIS, IsoSync, KeyRig, KeyStudio, LaunchPad, LeaderPlus, 
Lightning, ListSync, Lo-Fi, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, M-Audio, M-Audio Micro, 
Maxim, Mbox, MCXpress, Media Browse, Media Composer, MediaDock, MediaDock Shuttle, Media Fusion, Media Illusion, 
MediaLog, Media Reader, Media Recorder, MEDIArray, MediaShare, MediaStream, Media Suite, Meridien, MetaFuze, MetaSync, 
MicroTrack, Midiman, MissionControl, Mix Rack, MixLab, Moviebox, Moviestar, NaturalMatch, Nearchive, NetReview, NewsCutter, 
Nitris, NRV-10 interFX, Octane, OMF, OMF Interchange, OMM, OnDVD, Open Media Framework, Open Media Management, 
Palladium, Pinnacle, Pinnacle DistanTV, Pinnacle Geniebox, Pinnacle HomeMusic, Pinnacle MediaSuite, Pinnacle Mobile Media, 
Pinnacle Studio, Pinnacle Studio MovieBoard, Pinnacle Systems, ProEncode, ProServices, ProSessions, Pro Tools, QuietDrive, 
Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, RetroLoop, rS9, rS18, Salesview, Sci-Fi, Scorch, Scorefitter, 
ScriptSync, SecureProductionEnvironment, Session, Show Center, Sibelius, SIDON, Soft SampleCell, Soft-Clip Limiter, 
Sound Designer II, SPACE, SPACEShift, SpectraGraph, SpectraMatte, Sputnik, Starplay, SteadyGlide, Streamfactory, Streamgenie, 
StreamRAID, Strike, Structure, Studiophile, SubCap, Sundance Digital, Sundance, Symphony, SYNC HD, SynchroScience, 
SynchroScope, Syntax, TDM FlexCable, Thunder, Titan, Titansync, TL Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, 
TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, Torq, Torq Xponent, Transfuser, Trigger Finger, Trillium 
Lane Labs, TruTouch, UnityRAID, Vari-Fi, Velvet, Venom, VideoRAID, Video Slave Driver, VideoSPACE, VideoSpin, Vortx, Xdeck, 
X-Form, Xmon, Xponent, and X-Session are either registered trademarks or trademarks of Avid Technology, Inc. in the United 
States and/or other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or 
other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows 
is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other 
trademarks contained herein are the property of their respective owners. 
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